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Presidential Bits
by Paul Howard, President WACUG, president@wacug.org.

May’s meeting attendance suffered from the great weather, and the 
“attraction” of yard work, but an enthusiastic crowd thoroughly 
enjoyed Gabe Goldberg’s presentation “ A Little PC Cleaning 

Pays Off!” OLLI’s picnic tables provided an ideal venue for a physical clean-
ing demonstration with a shop vac, creating clouds of dust that could never 
be countenanced indoors. Simultaneously, a PC Clinic staffed by WAC’s 
Scott Hanak, and Roger Fujii and Nick Wenri of NCTCUG, helped get 
three computers that had been slowed to a crawl, back up and running ef-
fectively.
Summer Meetings at the Government Center
Beginning with our June 20th meeting, we’ll be back in Room 2/3 of the 
Conference Center at the Fairfax County Government Center, and plan to 
be there for the July 18th and August 15th meetings as well.  So, set your 
navigation system for 12000 Government Center Parkway, and join us for a 
summer of computers and technology!
June’s meeting: Nintendo Wii & Playstation 3: Just for Kids?
Chuck Roberts will introduce us to Nintendo’s system. While the Wii is 
not all that popular among hard-cord gamers, it is one of the most popular 
gaming consoles available. In fact, many industry pundits have pinioned that 
the Wii is vastly over rated. So what makes it so popular among families, se-
niors, and lots of young folks? Come see for yourself as Chuck brings his Wii 
to provide a demonstration (and possibly challenges members to a match) — 
are you up to the challenge?
Geof Goodrum will bring the group up-to-date on the Playstation 3. The 
Playstation Store (online) now has downloadable movies and TV shows for 
purchase and rent (many in HD).  You can store and view these from the 
PS3 hard disk. Playstation Home is a virtual 3D world to explore.  Meet and 
talk with other PS3 users around the world, view videos, play games, and 
customize your virtual self (avatar) and online living space. Purchase virtual 
items.
The PlayTV DVR (Dual Tuner HD) accessory is not available in the US, 
yet.  Bummer!

continues on page 10

president@wacug.org. 
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Lloyd’s Web Sites for June, 2009
by Lloyd Johnson, WACUG Member 

http://www.wacug.org/ is the URL for the Washington Area Computer 
User Group. Visit it for past issues of Web Sites with hyperlinks
June Sites: 

How many people have your name? – 1. www.census-online.us A list of 
people with your name is free; however, there is a cost for details.

2. Springtime Allergies – www.mayoclinic.com/health/springtime-
allergies/AA00060. Before you settle for plastic flowers and artificial 
turf, try these simple and effective strategies. A Mayo Clinic site. Re-
lated site: Hay Fever Resources: Mayo Clinic.Also www.nlm.nih.gov/
medlineplus/allergy.html

Journalism Help: Finding Data on the Internet3. .– http://nilesonline.
com/data This site may help.
Bankruptcy – 4. www.nolo.com/resource.cfm/catID/462A9501-9B21-
4E09-A08C5A7B8AF51A79/213. This Site features a FAQ , glossary, 
comparison charts, and other legal resources on Bankruptcy.

5. Day of the Week Calculator – www.searchforancestors.com/utility/
dayofweek.html. Enter the date to calculate the day of the week for 
an historic or future year. Related site: Calculate Days Between Two 
Dates.

6. Online Conversion –  www.onlineconversion.com. Convert just 
about anything to anything else. Over 5,000 units, and 50,000 con-
versions.
Gethuman – 7. www.gethuman2.com. When you’re tired of wasting 
money and time due to phone systems that require you to press 10 or 
more options in order to reach a real person and spending many min-
utes or even hours on hold, consult the GetHuman database of secret 
phone numbers and codes that immediately get an actual, live person 
on the line for customer service at nearly 1000 major companies.
The Hubble Heritage Project – 8. http://heritage.stsci.edu/index.html. 
The Hubble Space Telescope (HST) is a research tool dedicated to 
scientific studies of nature
Ready for some fantasy football? – 9. www.fantasyfootballhub.com



NCTCUG
Visit our “sister” user group. 
The National Capital Tech-
nology and Computer User’s 
Group meets the first and 
fourth Wednesday of the 
month. They meet in Carlin 
Hall in Arlington at 5711 
South 4th Street. Visit their 
web site for more informa-
tion, a map and directions:

h t t p : / / w w w. n c t c u g . o r g /

Meetings start at 7:00 PM

Washington Area User 
Group Partners

Working Together For 
Our Members

NCTCUG

WACUG

OPCUG

http://www.wacug.org/
http://www.census-online.us/
http://www.mayoclinic.com/health/springtime-allergies/AA00060
http://www.mayoclinic.com/health/springtime-allergies/AA00060
http://www.mayoclinic.com/health/hay-fever/DS00174
http://www.nlm.nih.gov/medlineplus/allergy.html
http://www.nlm.nih.gov/medlineplus/allergy.html
http://nilesonline.com/data
http://nilesonline.com/data
http://www.nolo.com/resource.cfm/catID/462A9501-9B21-4E09-A08C5A7B8AF51A79/213
http://www.nolo.com/resource.cfm/catID/462A9501-9B21-4E09-A08C5A7B8AF51A79/213
http://www.searchforancestors.com/utility/dayofweek.html
http://www.searchforancestors.com/utility/dayofweek.html
http://www.timeanddate.com/date/duration.html
http://www.timeanddate.com/date/duration.html
http://www.onlineconversion.com/
http://www.gethuman2.com/
http://heritage.stsci.edu/index.html
http://www.fantasyfootballhub.com/
http://www.nctcug.org/ 
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GNU/Linux SIG
By Geof Goodrum, WAC 

Initial Impressions: Kubuntu 9.04 on the Dell Inspiron 1100

In the interest of trying out the latest and greatest, I upgraded the Kubuntu 
GNU/Linux distribution on WAC’s Dell Inspiron 1100 laptop from 
version 8.10 to 9.04. The Inspiron laptop itself dates from 2003, so it is 

hardly cutting edge. The CPU is a 2.0 GHz Intel Celeron, the video chipset 
is Intel 845GL with 8 MB video memory, the display is 14” XGA. WAC 
previously upgraded the memory from 128 MB to 1GB, which dramatically 
improved performance. The laptop has a DVD-ROM drive and a 20 GB 
hard disk (10 GB allocated to Windows XP Home and 10 GB for a GNU/
Linux distribution).
Kubuntu 8.10 had a compatiblity issue with older Intel graphics chipsets like 
that on this laptop, which caused a screen lockup until the desktop effects 
feature was disabled manually. Previous versions of Kubuntu supported desktop 
effects on this laptop, but it is “eye candy” not essential for operation.
Happily, Kubuntu 9.04 seems to recognize the graphics chipset issue and 
disabled desktop effects by default when installed on this system. The new 
KDE4 desktop is pretty, but is significantly different from the default KDE3 
desktop in the previous version and requires some getting used to. I found that 
the desktop panels would disappear if KDE user settings were misconfigured, 
and only keyboard shortcuts could activate menu items. The easiest fix was to 
reinstall Kubuntu. I found that the new Network Manager, now implemented 
as a KDE4 desktop “plasma widget”, did not have a configuration option for 
wireless networks using the most secure WPA2 encryption feature. Open 
(unencrypted), WEP encrypted, and WPA encrypted wireless networks are 
supported. This issue is documented in the bug database with some suggested 
workarounds, but it indicates a lack of maturity in the new KDE4 desktop 
widgets (however, KDE4 can use Apple Mac widgets). Kubuntu 8.10 supports 
WPA2 wireless networks well, and had a better selection of desktop gadgets 
with more configuration options.
All in all, Kubuntu 9.04 works and looks nice, but the less adventurous should 
wait for the next Kubuntu release to allow some shakeout of KDE4 issues, or 
chose a more conservative GNU/Linux distribution (look for my upcoming 
article about CentOS 5.3).
The Kubuntu website has more information about the new features in version 
9.04 at http://www.kubuntu.org/news/9.04-release.
Google Wave: The Future of E-mail?
After a year of secret development in Australia, Google demonstrated at the 
Google I/O 2009 developer’s conference what e-mail could be if starting 
over using current technology. Brothers Lars and Jens Rasmussen, creators 
of Google Maps, were given permission to put together a team to investigate 
the possibilities. The result is impressive, even at this early stage. Using 
only the HTML5 web standard (compatible with browsers such as Firefox, 
Google Chrome, and Safari) and using some functions of Google Gears 
that they have proposed for the HTML5 standard, what Google is calling 

See Linux page 4

http://www.kubuntu.org/news/9.04-release


The Cursor —  June 20,  2009 Page 4  — www.wacug.org

Wave merges a number of existing technology bits 
and pieces into a collaborative messaging framework. 
Instead of e-mails being sent, copied, and replied to 
point to point with the 40 year old system in use today, 
the model is closer to a bulletin board where messages 
are stored centrally and shared among the designated 
recipients, who can update the message content with 
replies and corrections. If the recipients are online, they 
see message replies and updates character by character 
in real time (there will be an option to show replies/
updates only when complete). Message attachments 
such as files, videos, photos, etc. are available instantly 
and update dynamically. New recipients can be added 
to the discussion, and have the ability to playback the 
message thread to understand the chronological order 
of how it developed. The wave can be linked to a blog 
just by adding a blog ID as a recipient. Messages in the 
wave then get posted to the blog, and messages posted 
to the blog showed up in the wave. The demonstration 
included real-time contextual spell checking – the 
spell checker recognized the difference between “bean” 
and “been” as used in a sentence and made the proper 
spelling corrections. Another demonstration showed 
real-time language translation – both the original 
English text and a French translation appeared as it 
was typed. Other applications included user surveys 
and a playable chess game executed through a wave.
The Google team also demonstrated “Federation”, 
or how waves can be shared and distributed among 
servers. A group in one company can receive a proposal 
from outside the company, create a private discussion 
within the wave among themselves, and then make a 
reply to the external recipients. The private discussion 
is never distributed beyond the internal corporate wave 
server, so the outsiders never have access to it.
Best of all, Google is releasing “the lion’s share” of Wave 
code under an Open Source license, and has granted 
the developer community outside of Google accounts 
on the prototype system and information about the 
Application Programming Interface (API) with 
encouragement to try it out, suggest improvements, 
and begin building extensions. They made information 
about the wave protocol available for review, as well. 
By doing so, Google has a good chance at promoting 
adoption of Wave as a new open standard for messaging 
and collaboration. This model worked quite well for 
Google Maps and Google Earth.
Google plans to release Wave for public use in Google’s 

Gmail and other services later this year. Google’s 
web site about Wave is http://wave.google.com/, 
which includes a YouTube video of the entire 1hour 
20 minute Google I/O demonstration. The feature 
descriptions and videos on the web site will really help 
you appreciate the scope of this project.
Palm Prē Plans Announced
The new Palm® Prē™ smartphone became available 
from retailers on June 6th. The Palm Prē was previewed 
at the 2009 International Consumer Electronics 
Show and won both Best in Show and People’s Voice 
awards, and is receiving favorable reviews (e.g. http://
wtop.com/?nid=108&sid=1688939). The Prē features 
a true multitasking webOS™ operating system based 
upon the Linux kernel. Sprint is the exclusive service 
provider for the initial release. The announced price is 
$199.99 after a $100 rebate and activation of a two year 
Sprint Everything Plan with data service contract. 
Reports indicate that Best Buy stores will provide the 
rebate at the register. One of the initial applications 
availble from the online catalog allows the Prē to run 
software applications written for earlier Palm devices. 
Besides being a true multitasking smartphone with a 
multitouch gesture interface, the Prē features a fold 
out QWERTY keyboard, USB 2.0 connectivity, 
ability to interface with iTunes and Amazon to load 
and play DRM-free content, a 320x480 resolution 3.1” 
screen with 24 bit color, 3 MP camera, 8 GB built-
in storage, Bluetooth 2.1, 3G and Wi-Fi network 
with instant messaging, e-mail, web, and search, and 
GPS capability. For a complete list of features with 
video demos, visit the Palm and Sprint web sites at 
(respectively):
http://www.palm.com/us/products/phones/pre/index.
html
http://now.sprint.com/nownetwork/productPage.html

GNU/Linux Distribution Releases
GNU/Linux distributions are complete GNU/Linux 
operating system and application software collections. 
Many are freely downloadable or can be ordered on 
CDs or DVD at low cost. DistroWatch.com lists the 
following distribution release announcements for the 
period April 21 – June 3, 2009.

Distribution
ArtistX 0.7 Calculate Linux 9.6
Canaima GNU/Linux 2.0.1 CentOS 5.3 “Live CD”
Ekaaty Linux 3 Foresight Linux 2.1.1
grml 2009.05 Hacao Linux 4.21

Linux from page 3

http://wave.google.com/
http://wtop.com/?nid=108&sid=1688939
http://wtop.com/?nid=108&sid=1688939
http://www.palm.com/us/products/phones/pre/index.htm
http://www.palm.com/us/products/phones/pre/index.htm
http://now.sprint.com/nownetwork/productPage.html
http://distrowatch.com/5487
http://distrowatch.com/5496
http://distrowatch.com/5465
http://distrowatch.com/5492
http://distrowatch.com/5476
http://distrowatch.com/5480
http://distrowatch.com/5501
http://distrowatch.com/5498
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Hymera Open 20090601 iMagic OS 2009.5
Kiwi Linux 9.04 Kubuntu 9.04
Linux Caixa Mágica 14 Linux Mint 7
Mandriva Linux 2009.1 Mythbuntu 9.04
NetSecL 2.4 Parted Magic 4.1
PC/OS 10 “Open64 
Workstation”

Puppy Linux 4.2.1

Red Hat Enterprise Linux 
4.8

Sabayon Linux 4.1 “KDE”

Sabily 9.04 SimplyMEPIS 8.0.06
SystemRescueCd 1.2.0 Tiny Core Linux 1.4
Toorox 04.2009 Ubuntu 9.04
Ubuntu Studio 9.04 Webconverger 4.7
Xubuntu 9.04 Zenwalk Live 6.0

Linux Software of the Month
The software described below is downloadable at the 
links provided or may be requested on CD,  or copied 
onto a USB flash drive at the WAC meeting. In ad-
dition, WAC can provide CD-R and DVD±R media 
for any downloadable GNU/Linux operating system 
distribution (e.g. Fedora, Mandriva, Ubuntu, Debian, 
Knoppix). Please note that download versions of com-
mercial distributions do not include official technical 
support nor printed documentation.
Discs are available only by pre-order. Contact Geof 
Goodrum by e-mail (linux@wacug.org) at least 48 
hours before meeting day to order or for more infor-
mation. Single CD-R discs are available with a $3 do-
nation; GNU/Linux distributions on multiple CD-Rs 
or single DVD±R are available with a $6 donation.

June 2009

GIMP FX Foundry – v2.6.1. http://gimpfx-foundry.
sourceforge.net/. Free GNU General Public License 
script plug-ins for GIMP 2.6 by various authors. This 
release features 117 additional scripts for the GNU 
Image Manipulation Program (GIMP) to create spe-
cial effects with photos and graphics, including a Roy 
Lichtenstein effect to render graphics in the pop art-
ist‘s style, a script to antique photos, and a script to 
render a planet image.
Open Clip Art Library – v0.19. http://openclipart.
org/. Free Public Domain clip art in Scalable Vector 
Graphic (SVG) format. The Open Clip Art Library 
is a collection of royalty free (public domain) clip art, 
enhanced with creative commons metadata. It can be 
redistributed with free software or closed software and 
with various software distributions. This release con-
tains over 12,000 high quality graphic files released 
into the public domain by over 1,000 artists.

Pipewalker – v0.6.1. http://pipewalker.sourceforge.
net/. Free GNU General Public License C source code 
by Artem A. Senichev. This is a puzzle game where 
pieces of a computer network are to be turned in the 
right/left direction to make all computers connected 
to the same network. This game is clone of NetWalk. 
System requirements include OpenGL and X Window 
server.
PS3 Media Server – v.1.10.5. http://code.google.com/p/
ps3mediaserver/. Free GNU General Public License 
Java executable and source code. PS3 Media Server is a 
DLNA compliant Upnp Media Server, written in Java, 
with the purpose of streaming or transcoding any kind 
of media files from a PC to a DLNA client such as the 
Sony Playstation 3, with minimum configuration. It‘s 
backed up with the powerful Mplayer/FFmpeg pack-
ages. The server supports a wide variety of audio for-
mats (including OGG, FLAC, AC3, DTS, LPCM), 
video formats (MKV, FLV, OGM, AVI, MP4, TS, 
M2TS, MPEG), and image formats (JPG, PNG, 
GIF, TIFF).
Kernel Source – http://www.kernel.org/. 2.6 kernel 
source code for all platforms (stable 2.6.29).



http://distrowatch.com/5505
http://distrowatch.com/5445
http://distrowatch.com/5460
http://distrowatch.com/5438
http://distrowatch.com/5503
http://distrowatch.com/5491
http://distrowatch.com/5456
http://distrowatch.com/5439
http://distrowatch.com/5485
http://distrowatch.com/5469
http://distrowatch.com/5494
http://distrowatch.com/5494
http://distrowatch.com/5488
http://distrowatch.com/5482
http://distrowatch.com/5482
http://distrowatch.com/5455
http://distrowatch.com/5473
http://distrowatch.com/5447
http://distrowatch.com/5474
http://distrowatch.com/5448
http://distrowatch.com/5449
http://distrowatch.com/5437
http://distrowatch.com/5444
http://distrowatch.com/5446
http://distrowatch.com/5440
http://distrowatch.com/5471
mailto:linux@wacug.org
http://gimpfx-foundry.sourceforge.net/
http://gimpfx-foundry.sourceforge.net/
http://openclipart.org/
http://openclipart.org/
http://pipewalker.sourceforge.net/
http://pipewalker.sourceforge.net/
http://code.google.com/p/ps3mediaserver/
http://code.google.com/p/ps3mediaserver/
http://www.kernel.org/
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Make Your Wireless Network 
Safe

 By Marjie Tucker, Editor
Mountain Computer User Group

www.mcug.org
mcug(at)dnet.net

Wireless networks are becoming more and more popu-
lar, but they do add some additional security risks. You 
need to spend a little extra time to ensure that your 
data and your identity are secure.
What are the Risks?
Because wireless networks don’t require a cable be-
tween the computer and your Internet connection, 
it’s relatively easy for someone else to use your Inter-
net connection for free, to hijack your messages, or to 
sneak into your computer and view or steal your data.
So What Should I Do?
There are several important steps that you should fol-
low to protect yourself and your computer:
1. Don’t use a default password on your wireless equip-
ment. Most networking devices are pre-configured by 
the manufacturer with a simple password to simplify 
the setup process. This is the password that allows 
you to access the router configuration. These “default” 
passwords are well known by anyone who has used a 
similar device and they are available online, eroding 
any protection they might have provided. Check the 
instructions that came with your device and immedi-
ately change the password.
Remember that the best passwords contain both upper 
and lowercase letters as well as numbers. And, always 
shy away from passwords that can be easily guessed by 
your friends - such as the names of your children or 
your dog.
Experts suggest using a poem to derive a “pass phrase.” 
You merely take a line from a poem or poem title and 
use the first letter of each word. For example, using 
the poem “Mary had a little lamb” you would use the 
letters from the first line - Mary had a little lamb; 
its fleece was white as snow - mhallifwwas. Add at 
least one uppercase letter by capitalizing the M for 
Mary - Mhallifwwas. Next add at least one number 
by changing some of the letters to numbers, such as 
making the first letters for little and lamb into 1s. Now 
we have a phrase (Mha11ifwwas) that is reasonably 
secure and very easy to remember.

2. Restrict your network to only your computers. Every 
computer device has an embedded address on it called 
a media access control (MAC) address. Wireless access 
points and routers can be configured to exclude all 
other MAC addresses.
3. Encrypt the data on your network. Encryption 
prevents outsiders from viewing your transmissions. 
There are two methods of ensuring that your 
information is adequately protected, Wired Equivalent 
Privacy (WEP) and Wi-Fi Protected Access (WPA). 
Because WEP has several security issues associated with 
it, WPA is considered the more effective method, if it 
is supported by your equipment. However, since this is 
another area where a secure password is important, you 
should use a passphrase like I described in item #1.
4. Choose a unique SSID. You equipment may have 
a default name that identifies your network, called an 
SSID. Be sure to setup a unique name and, if possible, 
avoid broadcasting that name. That will make it harder 
for outsiders to find your network.
5. Install a firewall for your network. Microsoft Vis-
ta and XP both provide a firewall that is designed to 
protect your computer, but your network itself will be 
safer with its own firewall. A host based firewall is easy 
to obtain (some of them are free over the Internet) and 
can be installed directly onto your wireless device.
6. Install and regularly update both anti-virus and 
anti-spyware software. You can keep attackers at bay 
with these protective programs. However, remember 
to update both of them on a regular basis. New viruses 
and spyware attacks are being developed daily; so your 
software must be updated to be effective.
Obtained from APCUG with the author’s permission for 
publication by APCUG member groups.
This article has been provided to APCUG by the author 
solely for publication by APCUG member groups. All other 
uses require the permission of the author (see e-mail address 
above).
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Google Offers Free Medical 
Records Service

By Ira Wilsker, APCUG Director; Columnist, The 
Examiner, Beaumont, TX; Radio & TV Show Host

Iwilsker(at)apcug.net
WEBSITES:
http://www.google.com/health
https://www.google.com/health/html/privacy.html
http://www.keyt.com/news/local/19222464.html

Google recently opened for free public access 
the beta version of its “Google Health” ser-
vice at www.google.com/health. This service 

offers users access to a comprehensive user created da-
tabase where the user can selectively store medical re-
cords. In addition to the storage of personal medical 
records, Google Health also allows for the importa-
tion of medical and prescription records from a variety 
of services, and the voluntary exportation of medical 
records to several diagnostic services. Google Health 
allows user approved physicians, hospitals, pharma-
cists, and other healthcare services to access the medi-
cal records.
To open a free account at Google Health requires 
registration; users with existing Google accounts may 
use their existing usernames and passwords for access. 
Once registered, opening the website at google.com/
health offers the users an intuitive menu. The primary 
links in the center column of the page are: 
“Add to this Google Health profile (Learn about your 
health issues and find helpful resources)”;   “Import 
medical records (Copy and get automatic updates of 
your records)”;   “Explore online health services (Find 
online tools for managing your health)”; and “Find a 
doctor (Search by name, location, and specialty)”. On 
the left column of the opening page are hyperlinks to 
personal profile information, and the right column 
displays a profile summary.
Clicking on “Add to this Google Health profile” 
opens a menu with the headings “Conditions”, 
“Medications”, “Allergies”, “Procedures”, Test results”, 
and “Immunizations”. Under “Conditions” a condition 
or symptom can be entered in the search box, or the 
user can click on any condition in a lengthy alphabetical 
list to “Add” that condition to the user’s profile. Many 
of the conditions have a “Reference” link that will 
provide more information on the condition, as well 
as any symptoms and treatments. The “Medications” 

heading allows the users to enter both prescription 
and non-prescription medications, vitamins and 
minerals, as well as herbal products. The search box 
displays selections as the product name is typed, or 
an alphabetical directory can be accessed. “Allergies”, 
“Procedures”, “Test results”, and “Immunizations” are 
entered in the same manner as “Medications” and 
“Conditions”, with a search box or alphabetical menu.
The main page selection “Import medical records” 
allows the user to securely import medical and 
prescription records form a variety of sources, including 
clinics, laboratories, and pharmacies. Included on the 
currently short list of such resources are Beth Israel 
Deaconess Medical Center, Cleveland Clinic, CVS 
Minute Clinics, Quest Diagnostics, Medco, RX 
America, Longs Drugs, and Walgreen’s. It is clear 
in reading about the service that this small listing is 
in its infancy, as Google Health is trying to sign up 
additional partners. To experiment with importing 
data, I clicked on the link for the prescription manager 
Medco, which is utilized by my health insurance plan. 
Clicking on the “Link to profile” icon under the Medco 
listing opened the secure Medco website where I had 
to enter the username and password I use at Medco. 
Seconds after approving the transfer of my prescription 
history, it appeared on my Google Health profile under 
“Medications”. The information transferred to Google 
Health by Medco was not just the prescriptions I 
ordered from Medo, but also recent prescriptions I 
filled at local pharmacies where insurance was claimed. 
Medco can automatically update my profile as new 
prescriptions are entered and filled. Items filled at local 
pharmacies under their respective $4 or $5 generic 
program, where no insurance was filed, did not appear 
on the Medco list.
The menu item “Explore online health services” opens 
a list of over a dozen services that offer online per-
sonal health services. These health services which can 
be linked to Google Health and utilize the informa-
tion provided to Google Health (but only with the 
express consent of the user!) include such well known 
services as the Cleveland Clinic, the American Heart 
Association “Heart Attack Risk Calculator”, “My-
CareTeam- Diabetes” diabetes management system 
(requires monthly or annual subscription), and several 
other services. While several of these personalized ser-
vices are free, others are fee based. Most of the services 
listed require some form of registration in order to uti-

See Google page 8

http://www.google.com/health
https://www.google.com/health/html/privacy.html 
http://www.keyt.com/news/local/19222464.html 
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Google from page7

lizes those services and integrate them with the users’ 
Google health information.
The “Find a doctor” link opens a simple pair of search 
boxes, the first (left) of which is a directory of special-
ties, and the second box (on the right) is where the user 
can enter a zip code, city, or other information in order 
to generate a listing of physicians, chiropractors, and 
specialists that meet the selected criteria. The listings 
provided included physician or practice name, address, 
and phone number, as well as links to the practice 
website (if any), driving directions from Google Maps, 
and a link to “Save to medical contacts”.
Once information is entered, a personal profile is cre-
ated, and several analyses are made by Google Health. 
One that may be critically important shows up in the 
left column on the main page with the label “Drug 
Interactions” with a red exclamation point if there is a 
potentially dangerous interaction between prescription 
and non prescription drugs, vitamins, and herbals. On 
my personal page there is one advisory about a syner-
getic effect between two of my medications that says 
“Discuss with your doctor soon” (this effect is desirable 
in my case), and another interaction between three of 
my non-prescription medications that is labeled with 
a red icon “Requires immediate attention” (I already 
checked, and it is OK in my case).
In its privacy statement (www.google.com/health/
html/privacy.html), Google Health explains the con-
fidentiality of the information entered, and how it will 
not be released or shared with any third party with-
out the express consent of the user. By my personal 
choice, I would be willing to allow my personal physi-
cian (if he participated), as well as any specialists or 
hospitals that I visit, to access my information. It could 
be a great time saver to allow them to access my medi-
cal records online, rather than me having to complete 
hand written forms at each office I visit. Because of 
its inherent completeness, this online “Personal Health 
Record” (PHR) can also be a life saver by providing 
healthcare establishments instant access to medi-
cal histories, medications, and allergies. By having a 
voluntary service, such as Google Health, Microsoft’s 
upcoming competing service “HealthVault”, or “Revo-
lution Health” (bankrolled by by AOL’s co-founder 
Steve Case), which can be securely accessed by health 
care providers, it becomes easy to create and maintain 
an accurate health profile for both the benefit of the 
user and healthcare providers approved for access by 

the user.
It should be noted that there are always security and 
privacy risks of posting sensitive information, such as 
health records, online. It is quite conceivable that hack-
ers could penetrate the security of any establishment or 
server that contains or has access to sensitive personal 
information. While I know that they are not perfect, I 
basically trust Google Health with my information.
While there are many other “PHR” systems and servic-
es in use, often administered by corporations for their 
employees, others are offered by health insurance com-
panies, as well as some regional PHR services, Google 
Health has the reputation and distribution (as well as 
the deep pockets) to create and securely maintain such 
a system, and sign up participating partners who are 
willing to allow the sharing of medical records.
I knowingly volunteered to post my medical records 
on Google Health. I hope the project succeeds, and 
more local physicians, pharmacies, labs, and hospitals 
partner with the service. As more healthcare providers 
transition to purely digital medical records, it will be-
come easier to securely share this vital information.
Obtained from APCUG with the author’s permission for 
publication by APCUG member groups.
This article has been provided to APCUG by the author 
solely for publication by APCUG member groups. All other 
uses require the permission of the author (see e-mail address 
above).
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Bookmarks Page
by Hank Pearson, Treasurer and Webmaster, ASCIi 

(Arizona Association for Computer Information, inc.)
www.asciigroup.org

hank.pearson(at)asciigroup.org

Wouldn’t it be nice if you could view a search-
able webpage of bookmarks for your favor-
ite websites?  You can, but why?

Find Bookmarks with Forgotten Names
One reason to view your bookmarks as a webpage (as 
an alternative to looking in a menu) is to be able to 
find sites when you can’t remember the first word in 
the name.
Let’s say you have a Firefox bookmark named Carbo-
nite Online Backup, and you can’t remember Carbo-
nite but you know you are looking for the word Back-
up. On your Bookmarks page (you will soon learn how 
to view), you can easily search for Backup.
You are using Firefox, aren’t you?  If you haven’t dis-
covered Firefox, download it from Mozilla (http://
mozilla.com). It’s free, fast, and secure. Make Firefox 
your default browser.
View Bookmark Descriptions and Tags
Another reason for a bookmarks page is to give you 
plenty of room to view (and find) descriptions of your 
bookmarks. You will learn how to add tags to improve 
your searches.
Zoom In and Out
A third reason to display your bookmarks on a webpage 
is to allow you to zoom the text in and out so you can 
see it clearly. To zoom any webpage, press Ctrl+Plus or 
Ctrl+Minus, using the numeric keypad.
DIY for Fun and Learning
So, how do you display your bookmarks as a webpage? 
You could download a tool to do the work for you, or 
download a tool to search bookmarks. But it’s easy 
enough to DIY (Do It Yourself). It’s interesting, fun, 
and educational. Are you just using your computer to 
perform certain tasks, or do you also enjoy learning by 
experimenting?  If you like to learn, this tip is for you.
Find the Bookmarks File
You don’t need to create a bookmarks webpage. It al-
ready exists on your own hard drive!  The name of the 
file is simply bookmarks.html. Press Win+F to find it. 
(While holding down the Windows key (next to Alt), 

press F, for Find.)  In the left window pane, click ‘All 
Files and Folders’. In ‘All or part of the file name’, type 
‘bookmarks.html’ (without quotes).  Click Search.
If you get multiple results, it’s easy to determine which 
bookmarks.html file to use. It’s the newest one. In the 
View menu (of your Search Results window), click De-
tails. In the right window pane, click the Date Modi-
fied column header (to sort the list). The file you are 
interested in has the newest date and time (for a file 
with the Type shown as Firefox Document).
Bookmark the Bookmarks File
Double-click that newest bookmarks.html Firefox 
Document to open it in Firefox. Press Ctrl+D to book-
mark the bookmarks.html file. In the Name field, in-
sert a hyphen (-) at the beginning (to name the book-
mark ‘-Bookmarks’), so this new bookmark will appear 
at the top of the list.
Now, with your Bookmarks page displayed, press F5 
to refresh the view. (F5 is a common shortcut key for 
Refresh.) Surprise? The new -Bookmarks bookmark is 
at the bottom - not the top. Let’s address that. (This is 
Firefox 2.0.0.11. Future versions might vary.)
Create Another Top Bookmark
First, create another bookmark that will be displayed at 
the top. For example, open Google.com, press Ctrl+D, 
and name the bookmark -Google (starting with a hy-
phen).
Sort Your Bookmarks
Now, in the Bookmarks menu, right click any book-
mark, and click Sort by Name. Look in the Book-
marks menu to confirm that the bookmarks are indeed 
sorted. Note the two bookmarks that begin with hy-
phen (-) at the top of the menu.
Look at your Bookmarks page again, and press F5 to 
Refresh. The new bookmarks are still at the bottom.
Rearrange Your Bookmarks
To force Firefox to rearrange your bookmarks page, 
move a bookmark in the menu. In the Bookmarks 
menu, drag, for example, either new bookmark 
that starts with a hyphen up or down to precede or 
follow the other bookmark that starts with a hyphen. 
(Having two hyphen-prefixed bookmarks lets you 
rearrange those two at the top without rearranging 
the other bookmarks.) Press Escape to close the 
menu.

http://mozilla.com/
http://mozilla.com/
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Refresh your Bookmarks page with F5. The book-
marks on the webpage are now arranged as shown in 
the Bookmarks menu. (Do you need to refresh three 
times? No, we simply demonstrated that the book-
marks.html file is rearranged when you move a book-
mark in the menu.)
Finding Bookmarks on the Page
When you are viewing your Bookmarks webpage, 
press Ctrl+F for Find. Type Backup, for example, and 
press Escape (to close the Find toolbar). To find the 
next occurrence of Backup, press F3. (F3 is a com-
mon shortcut key for Find Again.) When you find the 
desired bookmark (link), click it (or Ctrl+click to open 
the site in a new tab). (Or press Enter, or Ctrl+Enter to 
open the site in a new tab.)
Add Descriptions and Tags
To add or change descriptions of your bookmarks, in 
the Bookmarks menu, right-click the bookmark you 
want to edit, and click Properties. In the Descrip-
tion field, type anything (including your own tags) 
that might help you find your bookmark and remem-
ber what it is for. After clicking OK and pressing F5 
(for Refresh), you will see your new Description in the 
Bookmarks page.
Make Changes through the Menu
Now that you know where bookmarks.html is located, 
you might be tempted to edit it directly with a text edi-
tor. Mozilla warns that it is automatically generated, 
so do not edit it, as your changes would be lost. Make 
your changes through the Bookmarks menu.
Displaying your Bookmarks as a webpage is a start 
in discovering many more tips and tricks related to 
Firefox.
 — Hank Pearson (hank.pearson(at)asciigroup.org) is 
the Treasurer and Webmaster for ASCIi (www.ascii-
group.org).He is a long-time member who frequently 
writes articles for the group’s newsletter, and has served 
as President, Secretary, Newsletter Editor, and Presen-
tations Coordinator

Obtained from APCUG with the author’s permission for 
publication by APCUG member groups.

This article has been provided to APCUG by the author 
solely for publication by APCUG member groups. All other 
uses require the permission of the author (see e-mail address 
above).
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For Geof, the PS3 is a winner because you can run 
alternate operating systems on the PS3, such as Yellow 
Dog or Ubuntu Linux. Ths system will run applications 
such as the OpenOffice suite on your TV.  It will use 
USB and network peripherals. Other strengths: Create 
and manage a digital media library - share media 
across a network with other DLNA devices.  Rip CDs 
to several audio formats. Upload and catalog digital 
video. PS3 has a native web browser built-in. Play 
DVDs and Blu-ray discs. Supports progressive mode 
and upscaling, SD to 1080p resolution.
Unlike the Wii, the PS3 doesn’t have a big library of 
fitness/personal enrichment type titles.  Most are sport 
or fight/war games. There are a several puzzle and 
creative games, which will be demonstrated as time 
permits.
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Home Financial Records
By Richard Kennon, Editor, Amador Computer Users 

Group, CA
www.acug.org

editor(at)acug.net

On August 7, 2007 Dick Johnson gave us an 
excellent presentation on “Personal Finances” 
with emphasis on record keeping and check 

writing. I, like Dick, have used QuickBooks to write 
my checks and keep my financial records. Recently, a 
friend chided me for not using BillPay at my bank. I 
had looked into this a long time ago and determined 
that my bank charged a little more than it cost to write 
a check and mail it – so no good. After my friend prod-
ded me to join the 21st century, I checked with my 
bank, again, only to discover that if they changed the 
name of my checking account, BillPay would be free. 
Done. So, I write many fewer checks than before. Per-
haps I can write them by hand! (Gasp) That is reason 
#1 for this effort.
Reason #2 is that the average household (at least mine) 
does not need the sophistication of an accounting pro-
gram to keep household records. About the only thing 
we need besides a check record (i.e. stubs) is a way to 
collect some information for the IRS each year. Twenty 
or twenty five years ago, I wrote such a program in Ba-
sic and used it for most of those intervening years. But, 
Bill Gates decided that he would no longer let me run 
Basic programs using his latest operating system. That 
program also printed the checks on an old Epson 24-
pin printer that served wonderfully for at least twenty 
years. That is when I turned to QuickBooks.
These two intersecting forces of minimal “accounting” 
and lowered demand for check writing led me to won-
der if, just maybe, an Excel spread sheet might do the 
job. Yes, I think it will. This thinking has resulted in a 
spread sheet that looks suspiciously like a check record 
in your check book. There are four added columns and 
they are “Account”, “Memo”, “Cleared” and “Recon-
ciled.” Maybe “account” is too grand a term. What I 
mean it to be is a code name that may apply to a num-
ber of different checks written to a number of different 
payees. This might be like lumping the electric, gas, 
water and phone bills under “Utilities.” Or, lumping 
Red Cross, American Cancer Society and Yosemite 
Fund under “Contributions.” But, then, one might 
write enough checks to one organization (i.e. Church 
at The Cross) to make that a separate “Account” like 
“Church.” The Cleared and Reconciled columns are See Homr Finaces next page

useful when it comes time to see if you and the bank 
agree. This is such an anxious moment that I use smi-
ley faces to indicate it is done. Here is an example of 
what the spread sheet looks like. It is assuredly a ficti-
tious account because I don’t think I know anyone with 
this much money.
See Fig 1
I had to scrunch it together to print it here. It looks bet-
ter on the Excel spreadsheet where I set it up to print 
in Landscape orientation so there is plenty of room for 
about 48 lines per page. There are lots more accounts 
you will want to use such as Taxes, Medical, Insurance, 
House Payments, etc. I am a terrible organizer so I am 
sure you can do a better job of this than I can. Think 
mostly of what you need for outside demands like the 
IRS. Don’t think in terms of detailed budgets because, 
admit it, you are not going to follow through with that. 
It seems as if I should be much more organized than 
I really am when I use QuickBooks or other account-
ing program. That is why I have a big “Miscellaneous” 
group in our personal records. That is none of the IRS’s 
business.
One nice thing about Excel is that when you start to 
type something you have typed above in the same 
column, Excel finishes the entry for you. So, we two-
fingered typists can create entries more quickly later in 
the year! I have anticipated that you and I will make 
less than 400 entries per year so have activated 400 
lines on each sheet. Of course, the spreadsheet does 
the calculations automatically. The sheet is locked ex-
cept for the columns where entries are required.
Now, how do we find out how much we gave to charity 
for the IRS? On the spreadsheet there is a little down 
arrow by each of the column headings that can be 
searched. Like this.
See Fig2
I have clicked on the Account column arrow and a choice 
box has dropped down. I have selected “Miscellaneous” 
and once I did that, this display popped up.
See Fig 3
Do that for any other account name or payee name and 
you will have the information you need for preparing 
your income tax. You can print this sub-list in the usu-
al way. Now, to get out of this, click the arrow in the 
same column and then click on (All). The original full 
list will show up. You can do that operation in either 
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the Payee or Account column and you will have all you 
need to find out how much money you have spent in 
any given category. For some fun, you can click on the 
arrows in the Check Number column and search for a 
check number or all the checks over some number or 
under a certain number. You can do the same in the 
Date column. This may come in handy when the sheet 
grows large late in the year and you want to find an 
entry made on or before or after a certain date.
See Fig 4
I did that here on the Check # column. Then I selected 
(Custom…). That sounds a little scary, doesn’t it? It’s 
not. The next thing to pop up is:
See Fig 5
You can choose “is greater than” or any other descrip-
tion of what you want to find. Then, on the right you 
type in the amount, say 500. Click OK and all the 
checks with numbers greater than 500 will pop up. 
Again, close this out by clicking the arrow and then 
(All).
A word of caution – be consistent. That is, do not call 
the electric company “PG&E” one time and “Pacific 
Gas & Electric” another time. Do not call an account 
“Charity” one time and “Contributions” another time. 
Keep it simple. Life would be simpler if we did not 
have to pay so many bills and it is also simpler if you 
use fewer accounts. Miscellaneous is a wonderful ac-
count.
Printing may also present a challenge. If you click 
View>Page Break Preview, you will see that 400 lines 
cover eight pages. If you just click File>Print>OK, you 
will get the pages you want plus all the blank pages up 
to eight. So, In order to get just what you want, click 
on View>Page Break Preview first to see what pages 
you want. Then you can select just those pages in the 
print window.
I will be glad to share this spreadsheet with anyone who 
wants to look at it more closely with the usual disclaimers 
about it is not my fault if you go bankrupt and so forth. 
You can copy the last blank sheet as many times as you 
wish so the workbook can last forever.
If you are interested in constructing your own spread-
sheet, here are some particulars that might be of inter-
est. What I call the search option is accessed by click-
ing on Data> Filter> AutoFilter. If you do this while 
in the Payee heading, it will put the arrows and the 

See Figs 1-5 next pages

function in all the contiguous headings to the right. 
I put a blank column after the Memo heading so it 
would stop there. The formula in the Balance column 
below the Beginning Balance is (are you ready for 
this?). =IF(OR(E9<>””, F9<>””), H8-E9+F9, “”). This 
is not so complicated. The classic IF statement says 
something like this: “IF (something is TRUE, then do 
this, else do that).” Now, the ‘something is true’ part 
says if cell E9 is not equal (<>) to blank (“”) or cell F9 is 
not equal (<>) to blank (“”). That is, if either of the two 
cells under the Amount heading or under the Deposit 
heading is not blank then… do some arithmetic. That 
arithmetic is subtract the Amount of the check and 
add the amount of the Deposit to the previous Bal-
ance, H8-E9+F9, in line number 9. The ‘else do that’ is 
leave this cell blank (“”). That is why all the cells below 
the active row are blank but will light up with a bal-
ance as soon as an entry is made. Just click on the + in 
the lower right corner and drag this formula down 400 
rows. Isn’t this slick?
With BillPay in full swing, I find that I write many 
fewer checks but I still have to keep a record, don’t I? 
The bank record is handy on the web but it only shows 
those charges that have cleared. I want to know wheth-
er I am solvent if they all clear. So I need a record. My 
accounting needs are mostly limited to keeping a ready 
record for tax purposes. Budgeting is not my thing. 
For these reasons a check record with the addition of 
an “Accounts” and a “Memo” column is satisfactory. 
The frosting on the cake is the added feature of being 
able to isolate various accounts and payees for whatever 
reason. While I may have made the transition to the 
21st Century, I have also simplified my life somewhat 
by not being dependent on Intuit to write my checks 
for me and demand that I account for every last penny. 
How often is it that computers simplify your life? 
This article may be used in any non-profit publication if 
credit is given the author and the Amador Computer Users 
Group of Jackson, California.
Obtained from APCUG with the author’s permission for 
publication by APCUG member groups.
This article has been provided to APCUG by the author 
solely for publication by APCUG member groups. All other 
uses require the permission of the author (see e-mail address 
above).
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Fig 2
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Fig 3

Fig 5
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Fig 4


